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UtilityWorks®  Release Notes

UtilityWorks now only works with GS/OS System Disk 5.0.4 or later, and all system
calls have been converted to GS/OS calls.

The following new features have been added to UtilityWorks version 0.8:

1. UtilityWorks is now in ExpressLoad format for better performance. Even though
version 0.8 is appreciably larger than previous versions, it will typically require less
memory to execute since extensive use is made of dynamic segments. A Memory
Window has been added to monitor memory status and an Out-of-memory Queue has
been added to automatically release additional memory when required. In some
instances (namely Backup and Restore) automatic memory purging is used to remove
unneeded memory and dynamic segments.

2. Full and Partial disk backup and Full and Selective disk Restore have been
implemented. The Disk Backup and Restore routines handle all devices recognized by
GS/OS, as well as both standard files and extended files. A very powerful Selective
Restore has been included that restores files using just a mouse point and click. Be
sure to read the version 0.8 documentation file before using the Backup and Restore
features.

3. Finder File Descriptor files are now used to provide a better description of files.
The File Descriptors are used for the Catalog function as well as for the Open... item in
the File menu and the Set File Type... item in the Utilities menu. The Catalog has been
expanded to provide additional relevant information.

4. Icons (provided with the documentation file) can now be used with the Finder to
automatically open (and optionally print) one or more Text Files chosen in the Finder.

5. The contents of the SHR screen can usually be printed with an Apple H
command.

6. AppleWorks 3.0 word processing files can now be displayed.

7. Animation files (from PaintWorks) are now displayed with full animation. Press
space to stop and any other key to continue the animation. Printed and saved
Animation Files will reflect the current contents of the Animation Window.

8. A High-ASCII to LOW-ASCII conversion has optionally been provided for
displaying text files written in High-ASCII.

9. The Device (Volume) Copy routine will now copy volumes where both the
source volume and the destination volume use the same device. Multiple disk
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insertions may be required to accomplish a single device volume Copy depending on
available memory.

10. The File Copy routine will now, on request, copy files from one file system to
another file system. This now provides a capability of copying, for instance,
AppleShare files to a ProDOS device.

11. Block devices can now be renamed. This is in addition to the Volume Rename
that was previously provided.

12. Foreign and special characters are now displayed and printed.

13. The File/Directory Selection dialog now provides a capability of displaying files
in either alphabetical or directory order. It also accepts double clicking on any
subdirectory to switch to that subdirectory or clicking on the current directory to drop
down to the next lower directory. Subdirectories are now indicated by a >> symbol.
Three character file mnemonics no longer are displayed in the selection dialog.

14. The Find File routine now implements a case insensitive match for ProDOS
files. Case is still used for other file systems.

15. The @ prefix is displayed in the Prefixes window to indicate the directory
UtilityWorks was launched from.

16. Capability has been added to optionally enable or disable the QuickDraw II
speedup options (fast port and hardware shadowing). With version 0.8, hardware
shadowing is nominally enabled and fast port is nominally disabled.

17. Purge memory will now optionally purge from memory all unused UtilityWorks
dynamic segments and the File Descriptor files.

18. Computer Info. has been updated to be compatible with System Disk 5.0.2.
Some memory information previously included in the Computer Info. window is now
displayed in a separate Memory window.

19. Text printing now properly handles non-standard paper lengths (US Legal, A4
Letter, and International Fanfold).

20. A capability has been added to load any CDA or NDA contained in any
directory on any device.

21. A Load Fonts capability has been added to load fonts from any directory on any
device.

22. A Print Fonts capability has been added to print samples of all Font Families
contained in the Font Manager’s list of fonts.

23. The default text printer has been changed to the serial printer.
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24. A Notification Proc has been added to allow GS/OS to inform UtilityWorks of
device changes.

25. A capability has been added to remove any device from the device poll (e.g.; a
5.25 disk can be removed from the device poll to improve performance).

26. The nominal default lines per page is now 66 lines per page rather than the
previous 60 lines per page. The catalog window default is now turned off so that the
catalog window will not appear when UtilityWorks is first executed (unless it was set in
your previous defaults to do so).

27. An information bar has been added to most windows to indicate the type of file
that is being displayed.

28. Font routines now check to ensure that any new fonts being added to the Font
Manager’s list of fonts have an appropriate font ID for the indicated font family, and
make appropriate changes if errors are detected.

29. Graphics printing is now word wrapped and includes the same header
information as text printing. Graphics printing now also prints foreign and special
characters if they exist in the file. Soft carriage returns have been implemented for all
text files to permit page resizing as fonts change.

30. A number of miscellaneous bugs have been corrected and numerous
miscellaneous improvements have been added.

31. Fixed a bug that prevented write protected extended files from being correctly
copied. (0.8A)

32. Updated the file type mnemonics to be consistent with the latest (May 1990)
Apple technical notes. (0.8A)

33. Fixed the Restore routine to properly restore any non-open file regardless of its
access privileges. Open files are skipped during file restoral. (0.8B)

34. If your Boot disk is in a 3.5 inch drive, the Boot disk will not be used for Backup
or Restore. Keep your System Disk in the Boot Drive. (0.8B)

35. Added a Bulk Format capability that will format multiple disks using the ProDOS
file system. (0.8B)

36. Provided more available memory for use by GS/OS as cache memory if
required. Cache memory limits should normally be set in the Control Panel NDA at
32K. Added additional dynamic segments to minimize memory requirements when
using most UtilityWorks menu items. (0.8B)
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The following new features have been added to UtilityWorks version 0.81:

1. Modified Backup, Restore, and Bulk Format to recognize Apple 3.5” drives
connected to a PC Transporter.

2. Changed File/Directory Selection Dialog Button name from “Device” to “Disk” to
be consistent with standard Apple Open File Dialog.

3. Modified File/Directory Selection Dialog to cycle through devices in reverse
direction whenever the keyboard’s Apple key is pressed at the same time that the
Dialog’s Disk Button is selected.

4. Computer Info windows are now printed in near letter quality using a 15 cpi font
when printing with  an ImageWriter. This eliminates the word wrap that occurs with the
larger default font.

5. Modified mode switch to close all NDAs prior to switching modes.

6. Altered the way default settings are saved. Defaults are now saved in the
resource fork of the UtilityWorks program file. UtilityWorks no longer requires the
UWGS.CONFIG file (although the UtilityWorks Launcher still does use this file). You
must reenter any desired default changes, including the password.

7. A Key Caps display has been added to the View Fonts... menu item. Key Caps
shows the correspondence between font characters and the Apple IIGS keyboard,
including the effects of pressing the shift, option, and option-shift keys.

8. A Cat. Data Base menu item has been added. This item creates an ASCII file for
input to standard data base programs (including AppleWorks and AppleWorks GS).
The ASCII file contains complete Catalog information for all files in the selected tree
directory, tree branch, or volume. This greatly facilitates creating an AppleWorks data
base of all of your files.

9. Added a Bulk Verify capability that will verify multiple 3.5 inch disks. This routine
is particularly useful in ensuring that your set of Backup disks has no bad blocks.
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The following features have been added to UtilityWorks version 0.9:

1. Added a full Text Edit capability that allows creation of new editable windows, or
creation of editable windows for all standard text based files capable of being read by
UtilityWorks (e.g.; text, source, AppleWorks word processing, Applesoft files).
Capability to cut, copy, paste, and clear are provided, as are capability to set the ruler
(e.g.; margins, paragraph indentations, line spacings, and text justifications) and
choose any font, font size, font style, and font color.

2.  Added a capability to find any user specified text string in any Text Edit window.
Also provided the capability to find all multiple occurrences of this text string.

3. Added capability to save any Text Edit window as either a Text file or a Teach
file (new Apple format for Text Edit files that preserves all style information). Also
added the capability to Open previously saved Teach files, including those generated
by other programs.

4. Added capability to print any Text Edit window in either text or graphics mode.

5. Added a capability to Verify backup disks as they are created, thereby
permitting immediate recreation of any bad backup disks.

6. Added another defaults option permitting elimination of many non-essential
messages, especially during file and disk operations.

7. Provided several new keyboard equivalents to menu items, and added several
new menu items, including:

Select All OA-A
Find Again OA-G

Changed OA-F keyboard equivalent to be used with Find String... rather than Find
File...

8. Fixed a problem that occasionally resulted in animation file updates going to the
wrong port when multiple animation files were present.

9  Fixed three minor token errors which occurred when displaying Applesoft files.

10. Fixed a problem that prevented the UtilityWorks file itself from being backed up
due to an open resource fork. (0.9A).
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11. Carriage returns can now optionally be stripped off within a paragraph when
saving a text file using Save As.... This provides a convenient method of generating
text files that can easily be processed by word processors that do not like embedded
carriage returns within paragraphs. (0.9B).

12. UtilityWorks is now fully compatible with the new version of GS/OS that comes
with the latest Apple High-Speed SCSI card. Earlier versions of UtilityWorks have two
direct page handles that are not properly disposed of (but only when using this new
version of GS/OS). These open handles will prevent launching of P8 programs from
either UtilityWorks or UtilityLaunch. If you are also using UtilityLaunch, make certain
you are using UtilityLaunch Version 1.9 or later, which corrects the same problem in
UtilityLaunch. (0.9B).
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UtilityWorks version 0.9C is essentially a maintenance upgrade and includes the
following changes:

1. Use of wait cursor for most disk and file operations requiring any appreciable
wait (in addition to already existing status window indicating current  progress of the
operation).

2. Incorporation of status window in Save As... menu item to indicate when text
reformatting is taking place.

3. Addition of a LaserWriter initialization sequence whenever Graphics printing is
taking place to work around a problem in the current LaserWriter drivers.

4. Incorporation of a workaround for a GS/OS Format and Erase dialog cancel
error to permit cancellation of the operation with no further action.

5. Incorporation of an improved Shutdown Sequence that properly closes down
all tools while maintaining a direct page stack.

6. Addition of new file types current to the July 1990 Apple Technical Notes and
File Type Notes.

7. Addition of MIDI Synth Tool to the Computer Info window.

8. Provision for Device (Volume) Copy of volumes of unequal number of blocks
and/or unequal block size. This permits you to copy the entire contents of one volume
to another volume of equal or larger size. The primary purpose of this capability is to
permit backing up a hard disk or hard disk partition to another larger hard disk or hard
disk partition (or alternatively a tape backup device, with appropriate drivers). This
same Device Copy routine can later be used to restore all data to the original disk. A
warning message appears for any unequal volume size copy unless you are using a
SCSI Tape Backup device. If you are copying to a SCSI Tape Backup device you are
furthermore given the opportunity of optionally clearing all backup bits. Always make
sure the backup tape is ejected prior to clearing the backup bits. Unless you are
restoring previously backed up data, never copy to a volume of smaller size than the
original source volume. The file structure may not be correctly preserved if you do so.
Note, this capability has been tested with unequal size volumes, but has not been
tested with any actual tape backup devices.

9. The Clear Backup Bits menu item will now clear the backup bits for all files
treeing from selected directories, not just all selected files in the current directory.

10. Corrected a problem in display of Apple Preferred Format files when the
number of scan lines in 640 mode pictures was not at least 200 (most noticeable for
some Apple Preferred Format files generated by AppleWorks GS in reformatting its
object-oriented graphics files).
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11. Corrected two errors in the Purge Memory routine, one which indicated an
erroneous number of bytes purged and another which hung the computer if there was
not at least one window present on the Desktop. This latter error also could result in
the computer hanging in routines that automatically purged memory, such as Backup
and Restore, if the Desktop contained no windows.

12. Corrected an error in display of packed and unpacked QuickDraw PICT files.

13. Changed Save As... to save object oriented graphics files as unpacked $C1
QuickDraw PICT Aux Type $0001 files.

14. Added a message indicating “String not found” when the input string is not
found during a Find String... menu item search.

15. Changed the Options... menu item to not display the Password entry item after
the Password has been correctly entered.

16. Inhibited the update of all pictures using the DrawPicture call if the System Disk
is offline. This was done because DrawPicture is in a dynamic segment which may not
already be in memory. Such pictures will appear as white (clear) windows.

17. The Out-of-memory Queue buffer is now set at 32K instead of 16K to ensure that
all tool calls can be made.
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The following features have been added to UtilityWorks version 0.9D:

1. Incorporation of printer error messages (mostly for AppleTalk printer
configurations) that explain the printer error that has occurred.

2. Graphics printout of pictures can now be performed in Better Text mode, instead
of just the previously available Better Color mode. Better Text mode should only be
used for high contrast pictures, such as those involving text, since it produces only
limited shades of gray.

3. Incorporation of changes to properly print all fonts and font styles in Better Text
mode.

4. Incorporation of an improved word wrap algorithm to wrap text to the next line
when printing text files using Graphics printout. The actual size of each line is now
computed to give better results with proportional fonts.

5.  Speedup no longer automatically closes all windows prior to changing
QuickDraw II speedup options. Windows are no longer closed except when turning
hardware shadowing on or off, and the user is prompted in this case as to whether he
wishes to continue with this action.

6.  Added a message to indicate Changing Modes when changing from 640 mode
to 320 mode or vice versa. Also ensured that no QuickDraw II speedup changes occur
during mode change.

7. Revised the View Fonts... selection dialogs to better indicate the results when
displaying the requested font, font size, and font style in a front window or in a window
containing either a sample of all font characters or Key Caps showing the
correspondence of font characters to keyboard keys.

8. Incorporated new QuickDraw II features to print all standard windows exactly as
shown on the screen, including all character spacing. Word wrap is however adjusted
to the actual width of the paper whether in Landscape or Portrait mode.

9. View Fonts can now change the font, font size, and font style of catalog windows
to permit use of smaller font sizes to print out the catalog in Portrait mode during
graphics printing. Always keep the character spacing at character 0 or nonproportional
spacing to assure columnar alignment, or use a nonproportional font such as Courier.

10. Changed the tab positions in Text Edit windows to every 40 pixels (about  every
0.5 inches) to give more accurate control of text spacing.
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The following changes have been made to UtilityWorks version 0.9E:

1. Modified the Open... , Save As... , and Launch...routines to avoid hanging if
prefix 8 is no longer on line.

2. Fixed a bug in the File/Directory Selection Dialog which prevented selection of
file list subdirectories by double clicking when the directory list is showing files and
has no further subdirectories.

The following changes have been made to UtilityWorks version 0.9F:

1. Added file types/auxiliary file types current to Apple’s September 1990 File
Type Notes.

2. Implemented Apple recommended workarounds to several toolbox problems
existing in System Disks 5.0.2 and 5.0.3. These workarounds include use of a Text
Edit Ruler template pad for tabs and avoiding near bank boundary conditions and
small buffers when using the UnPackBytes call.

3. Fixed a problem that existed in decoding Packed QuickDraw PICT files (file type
$C0, Aux type $0003).

4. Added a capability to display 3200 files (but only using the default  system
palette). This capability will show the general characteristics of the image but will not
show the great color that is possible with true 3200 color display.

5. Apple has established a new recommended practice to avoid conflicts between
NDAs and applications, such as UtilityWorks, in closing of files. If an application closes
files with a reference number of 0 (i.e.; closes all files) at level 0, it may also close a file
that an NDA has opened and still assumes to be open. In general UtilityWorks avoids
this problem by only closing those files that it has previously opened. However in
some instances UtilityWorks does close all files to ensure that operations such as file
copy or Backup/Restore can be performed. In most of these instances all NDAs have
already been closed by UtilityWorks. The particular UtilityWorks routines that close all
files at level 0 are: File Copy, Backup, Restore, and Catalog Data Base. Avoid using
NDAs which perform file operations when you are using any of the above UtilityWorks
routines.

The following changes have been made to UtilityWorks version 0.9G:

1. Added the selected character device (used for printing in text mode) to the
defaults saved in the resource fork of the UtilityWorks program file. This character
device is saved as long as you save the defaults subsequent to selecting the character
device.
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The following changes have been made to UtilityWorks version 0.9H:

1. The Files/Directory Selection Dialog has been modified to include a Volumes
Button instead of the former Disk Button. Pressing the Volumes Button (or the
pathname appearing above the files list when it indicates a root or volume name) will
result in a list of all on-line volumes appearing in the list of files. The user can select
any desired next volume by either double clicking on a volume name in this list, or
selecting a volume name and pressing the Open Button. The root directory of the
selected volume will then appear. The notation for indicating subdirectories has also
changed from the previous “»” character to a “:” character to be more consistent  with
standard GS/OS separator characters used for subdirectories and pathnames. This
same notation is also used in the Selective Restore Dialog. This change makes it
much easier to move from one volume to another.

2. The Text Printing routine now checks the page length for all paper types
indicated in the Page Setup... Dialog and issues appropriate ImageWriter paper length
commands if you are using an ImageWriter printer. You must still set the number of
lines per page in the Options Dialog to a value that is less than the page length.

3. The Graphics printing routine no longer requires that pictures be displayed in
the proper mode to achieve color printout using the correct palette as long as you are
using System Disk 5.0.3 or later.

4. The Open... routine now permits selection either individual files or multiple files.
The multiple file selection dialog will be displayed if you press the Open-Apple key as
you click the mouse on the Open... menu item. This multiple file selection dialog looks
almost the same as the individual file selection dialog, except that it includes an
Accept button. This Accept button is used to indicate that you have made all of the
desired multiple file selections. The Open button can still be used with this dialog if you
only make a single file selection. Make multiple file selections using the shift and
option keys as described in the previous File/Directory Selection Dialog discussion. If
you desire to open Binary picture files you must use the individual file selection dialog
(binary files appear as dimmed entries in the multiple file selection dialog). This
restriction is necessary because of a bug in the Standard File tool call that prevents
the use of filter procedures which are required for determining file length.
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5. If you are using System Disk 5.0.3 or later, you can use the following keyboard
equivalents for both the individual and multiple file selection dialogs used with the
Open... routine. (These equivalents cannot be used with the File/Directory Selection
Dialog, however).

Key Action

Esc or Close
Command-Up Arrow

Tab Volumes

Command-period Cancel

Command-o or Open
Command-O or
Command-Down Arrow

Command-n or New Folder
Command-N
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The following changes have been made to UtilityWorks version 0.9I:

1. Added File Descriptor data base category (inserted as new category 7) to the
CAT Data Base. This data will be inserted in the file’s data base information as long as
the total length of the file’s information is less than 255 characters. This will almost
always be the case with standard setups. The File Descriptor information gives a brief
description of the type of file and should be very useful in assisting in recognition of
files. Removed the previous leading space that was inserted for hours less than 10
and days less than 10.  This provides date and time compatibility for use with
programs such as Excel.

2. Changed the filter procedure for the Open... item to allow selection of
AppleWorks GS files as well as TXT and BIN type 3200 files. The latter two kinds of
files must have a file name with a “.3200” extension. The multiple file selection dialog
is now the standard Open... menu item dialog. The single file selection dialog can still
be used by pressing the Open-Apple key as you click the mouse on the Open... menu
item. Both dialogs now use the same filter procedure.

3. The Open... menu item can now be used to display AppleWorks GS Word
Processing files. These files appear in a window in much the same format as standard
AppleWorks files. The information is very legible, but does not follow all of the
formatting you would see if you displayed the file using the AppleWorks GS program.

4. 3200 files are now converted to a 320 mode SHR screen display with a
monochrome (16 levels of gray) palette. This gives a relatively good Black & White
version of the 3200 picture for use in Printing and Saving to disk. Pressing Open-
Apple 3 while in 320 mode with the 3200 picture in the front window will result in a
high quality 3200 color display of the file. Pressing any key or the mouse button will
exit this display. This 3200 color display uses a routine developed by Jonah Stich and
modified by Dave Leffler and myself.

5. Added Clear Text Screen when Quitting UtilityWorks.

6. Fixed an array initialization problem in Selective Restore that occasionally
resulted in files and/or directories other than those explicitly selected being restored.

7. Fixed a bug in Applesoft file display that caused line numbers greater than
32768 being displayed incorrectly.
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The following changes have been made to UtilityWorks version 0.9J:

1. Changed alert windows to properly display text messages containing the
character “/” embedded in the text message.

2. Corrected a bug that in certain instances prevented correct setting of font IDs.

3. Corrected a problem that resulted in NDAs with High-ASCII names being
incorrectly displayed in the Install Dialog.

4. Corrected a problem that resulted in trash appearing in standard windows
containing large fonts (font size > 18) whenever speedup option or mode changes
were made.

5. Fixed 320 mode dialog and status window display problems so that all allowed
dialogs and status windows will now appear correctly in 320 mode.

6. Menu bar date and time as well as the memory status window are now updated
continually with many dialogs.

7. Block devices with removable media (except for 5 1/4 inch drives) are now
continually polled. The devices window, devices dialog, and file/ directory selection
dialog are now updated whenever a volume is removed from or inserted into such a
device.
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The following changes have been made to UtilityWorks version 0.9K:

1. Changed Save As... to save the current position of a Text Edit window when it is
saved as a Teach file so that it will be displayed in the same position when it is
reopened.

2. Changed the nominal characters per line in standard windows to 74 instead of
80. This will minimize the amount of horizontal scrolling that must be done to read text
in a standard window. Please note that word wrap in standard windows is still only
implemented when a text based file contains more than 255 characters without a
carriage return. This allows you to easily view long text lines that often occur in such
files as source files.

3. Whenever the contents of a Text Edit window is changed, the color of the title
bar is now changed (becoming white text on red for the front window and black text on
orange for all other windows) to make it more apparent that the contents of the window
has changed and should be saved. When the window is saved as a Teach file, the
standard window title bar colors (white text on black for the front window and black text
on white for all other windows) are restored.

4. Improved the error diagnostics in the disk (volume) Copy, Format, Erase, and
Rename routines.

5. Made a one pixel change to the width of picture windows to prevent icon files
from changing color as they are scrolled horizontally.

6. Precluded all initial segments from loading into special memory to avoid
potential problems in establishing the SHR screen.

7. Corrected a bug that occasionally resulted in erroneous pathnames when
switching disks while executing several routines.
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The following changes have been made to UtilityWorks version 0.9L:

1. If a verify error is detected when verifying backup disk 1 (UWGS.BU.01), the
backup is aborted. Verify errors detected on all other backup disks will permit
regeneration of that backup disk using the same or another disk. Skipping
regeneration of disk 1 is necessary because the regeneration process does not create
the required reference files contained on disk 1

2. Added a menu item (Set File Date...) in the Utilities menu to set a file’s date and
time attributes. You must first select the file(s) you want to change. For each selected
file you are presented a dialog that indicates the file’s current modification date and
time as well as its creation date and time. Input the desired month, day, year, hours,
minutes, and seconds for both the modification date and the creation date. Months go
from 1-12, days from 1-31, years from 00-99 (i.e.; 1900-1999), hours from 0-23,
minutes from 0-59, and seconds from 0-59. Please note that seconds are not
recognized in file directories by current versions of GS/OS. Check boxes below each
entry can also be used to zero the time values, set the modification date and time to
the creation date and time or vice versa, or set the date and time to the Apple IIGS’s
current date and time. Press OK to make the change or Cancel to skip this file.

3. Now switch to  an I beam cursor whenever the front window is a Text Edit
window and the cursor is positioned over the content portion of that window.

4. Corrected a bug that occasionally resulted in an incorrect return from defProcs.

5. Now draw a different menu bar in 320 mode that only displays those menu
items which can be used in 320 mode. These menu items are a subset of the full 640
mode menu selections.
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The following changes have been made to UtilityWorks version 0.9M:

1. The mask for the version number as displayed in Computer Info. was changed
to be consistent with Apple’s revised guidelines.

2 Reading Text or Teach files of zero length previously resulted in either no action
taken or error messages (e.g.; parameter out of range) that were not descriptive of the
error that actually occurred. Descriptive error messages are now used. If a Teach file
has a zero resource length (as may occur when attempting to transfer these files over
a network without using a program such as ShrinkIt GS that can properly handle
resource forks), the file can still probably be displayed if you change the filetype to a
TXT file using the Set File Type... menu item. Attempting to save a file with zero length
(such as a newly created Text Edit window) will also now produce a descriptive error
message.

3. The Save As... menu item now has another option which performs a Quick Save
of Text files. The Quick Save saves the text based data exactly as it appears in
memory, and does not either detab the file or strip out returns. This option is much
faster than the other two options which must create a new text file in memory. The
Standard Save option detabs the file in memory before saving it. The Strip Returns
option both detabs the file and strips out any carriage returns occurring within
paragraphs.

4. When a Teach file is saved, the title of the saved file now becomes the window
title.

5. Text files that are 3200 color files are now only selectable if the .3200 suffix is
used in the file name.

6. A capability has been added to allow saving of almost any screen image when
using UtilityWorks. It works much as the OA-H capability which prints almost any
screen image. Simply use OA-D to save the desired image. You will be presented with
a Standard File dialog to select the directory and file name. This capability works in
both 640 and 320 modes.

7. Corrected a bug which resulted in the Open... menu item’s filter proc potentially
clobbering a GS/OS system memory location.
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The following changes have been made to UtilityWorks version 0.9N:

1. Added a UtilityWorks default option (Options... item in the Goodies menu) to
disable automatic polling. It is advisable to disable automatic polling if you have a
UniDisk 3.5 inch drive connected to your Apple IIGS. UniDisk 3.5 inch drives will be
continually turned on and off if automatic polling is enabled.

2. Added an eject item to the Device menu. This item will eject all ejectable media
other than 5 1/4 inch disks. Use this item or its keyboard equivalent (Open Apple-E) to
conveniently remove all disks from your drives.

3. Changed the name of the Goodies menu to Utilities which is more descriptive of
the items in this menu. All documentation has been revised to reflect this new name.

4. UtilityWorks now sends the name of the document being printed to AppleTalk. It
now also automatically opens a new document whenever more than 128 pages are
being printed.

5. Now turn the SHR screen off and display a Text Screen Mount Volume
message if there are any errors during initial tool loading.

6. Added a new Window pull-down menu.  The Window  menu contains a menu
item for each UtilityWorks active window. It does not include any NDA windows that
may be open. The title of each window appears in the pull-down menu, with the front
window indicated by a check appearing to the left of the title. Selecting any menu item
in the pull-down menu will immediately bring that window to the front. The Window
menu is extremely useful when you have a large number of open windows on your
desktop, especially when they are fully zoomed as they typically are in 320 mode. You
don’t have to move the windows around to find the one you want to click on to bring to
the front. Merely click on the desired window in the Window menu.

7. During Backup, Restore, Cat. Data Base, and Show Tree, if you elect to clear
the desktop (i.e.; close all open windows), UtilityWorks will now temporarily shut down
and unload the Standard File and Text Edit tools to maximize available memory.
These tools will be immediately reloaded and restarted as soon as the selected
routine completes its operation. This will not interfere with any NDAs because they are
closed when the desktop is cleared and may not be reopened until the operation
completes.

8. Added a capability to view diacritic characters in the View Fonts Key Caps
option.  Diacritic (foreign) characters result when you depress the Option key
simultaneously with one of the character keys e, i, n, u, and ` followed by a specific
character key (a, e, i, n, o, u, y, A, E, N, O, U, or space). Just press the option-
combination radio button to see the various character mappings to the  diacritic
characters.
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9. Since most users performing file operations normally perform several similar
operations in succession, UtilityWorks has been modified to immediately return to the
file operation being performed upon completion of the current operation. To
discontinue the operation, press Cancel in the file/directory selection dialog. Repetition
of file operations will occur with the File menu’s Copy..., Move..., Delete..., Rename...,
and Verify... operations.

10. When displaying picture files, menus may appear in colors that render the text
in the menu bar illegible. Use the keyboard equivalents to the menu items if the pull-
down menus are illegible. If the picture appearing in the front window uses only palette
0 (most pictures do use only this one palette), it is possible to initialize the Apple icon
in the menu bar to the normal default screen colors, while still preserving the colors in
the picture. Simply press Apple-I to initialize the Apple icon’s normal colors in either
320 mode or 640 mode.

11. The Backup routine has been modified to allow recovery from most errors, not
just read errors occurring during verification. If you get an error when backing up to
any disk after the first one, you will probably be asked to insert a usable disk and
continue. You can reinsert the current disk or put in a new disk. UtilityWorks will then
attempt to rewrite the backup information to that disk.
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The following features have been added to UtilityWorks version 0.9.1:

1. The current time appearing in the menu bar is now updated with all dialogs
except Alert and Error windows.

2. File types have been updated to be consistent with the March 1991 Apple
Technical Notes.

3. Selected files in the File menu’s Copy and Move dialogs are no longer dimmed
if you select a new volume for the destination directory.

4. Corrected a bug in the Show Clipboard menu item which prevented having
multiple windows showing the graphics clipboard.

5. The File Copy..., Show Tree..., Backup..., Restore..., and Cat. Data Base... menu
items now all open and close files at level 1 to prevent possible conflicts with NDAs
and GS/OS.

6. The Information Bar for 3200 files and Animation files now contains help
information for displaying the files when in 320 mode.

7. Added a Show Tree... menu item. This routine will display the directory tree (i.e.;
an indented listing of all folders or subdirectories contained in the selected tree
branch). The user is first asked to select the volume or starting directory. Any on-line
volume or directory may be selected as the starting directory. UtilityWorks then
analyzes the volume to find all subdirectories treeing to the selected starting directory,
and displays this information in a window. As with other UtilityWorks windows, this
information can be printed (in either text or graphics mode) or saved to disk as a TXT
file. Unlike many other windows, however, the fonts may not be changed from the
default system font. Clicking the mouse on any directory name will cause the
pathname of that directory to be set as the default directory for the Open... standard file
selection dialog as well as the file/directory selection dialog used for file operations.
This provides a convenient way to quickly change default pathnames. When you click
the mouse on a directory, the resultant pathname will appear in the Information Bar.
The desktop may contain multiple copies of the Tree window for the same or different
volumes, but all of these Tree windows will be automatically closed if you switch the
display to 320 mode.
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The following features have been added to UtilityWorks version 0.9.1A:

1. Corrected a bug in the routine that displays Printer Error messages to allow for
error messages longer than 40 characters.

2. Corrected a bug that occasionally resulted in erroneous volume not found
errors in the directory selection dialog.

3. Find File now sets the default pathname for the directory selection dialog in
addition to the file selection dialog and the standard file dialog. This now permits you
to do a catalog of the directory containing the found file more easily

4. Fixed a bug that prevented copying of very large files to a 3.5 inch disk.

5. The file selection dialog now does not require reselection of previously selected
files even if the original selection was made prior to any destination directory being
selected.

6. The default directory for the directory selection dialog is now contained in prefix
13. Previously it was contained in a global pathname that was also used for other
purposes. This change should eliminate the occasional default anomalies observed in
the directory selection dialog. Prefix 8 is still the default for the Standard File selection
dialogs (e.g.; Open... menu item), and prefix 9 is still the default for the file selection
dialog.
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The following features have been added to UtilityWorks version 0.9.2:

1. Changed the Select DAs menu item into two separate menu items, Install DAs
and Loader Actions, to better describe the respective actions taken and avoid
potential confusion. Install DAs installs Desk Accessories that were not installed at
initial boot. Loader Actions allows you to specify which Desk Accessories (CDAs and
NDAs), File System Translators (FSTs), CDevs, permanent and temporary initialization
files (INITs), and drivers will be loaded at your next boot.

2. The Options dialog was changed to better reflect the action that will result from
setting each specified item. The category “Other Options” now includes:

• “Show Initial Catalog Window”
• “Show Initial Devices”
• “Show Initial Prefixes”
• “Open Text Files in Edit Windows”
• “Convert High ASCII to Low ASCII”
• “Show all Info. Messages”
• “Inhibit Polling”
• “Enable Menu Clock”

The “Open Text Files in Edit Windows” and “Enable Menu Clock” options are new and
are discussed below.

3. Display of the menu bar time is now an option and may be disabled in the
Options dialog. Disabling the menu bar clock is useful if you are using an NDA that
also writes the time to the menu bar. You can still display the date by pressing the
mouse on the menu bar area that previously contained the time.

4. Text based files (Text, AppleWorks, AppleWorks GS, Source, and Applesoft
files), other than Teach files, were previously opened in standard non-editable
windows. They had to be converted to Edit windows (using the Edit Text item) and
generally zoomed if you desired to edit these files. Text based files are still nominally
opened in this manner, but a new option in the Options  dialog permits you to open all
text based files in fully zoomed Text Edit windows. This avoids having to go through
the additional steps if you intend to edit these files instead of just viewing them.

5. The New item now produces a fully zoomed Text Edit window in place of the
smaller window to permit easier entry of text without having to zoom the window.

6. Added an information bar to all Text Edit windows, except those produced by
the New item. This information bar contains the same file descriptor information as
standard windows.

7. Fixed a printing problem when printing Text Edit windows in Graphics mode that
sometimes resulted in printed text having a fuzzy appearance.
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8. Colored text in Text Edit windows will now print properly using dithered colors in
640 mode.

9. Fixed a minor problem that resulted in incorrect display of 640 picture colors
when scrolled to rightmost position after having been switched to 320 mode and back.

10. Fixed a problem whereby selected text was not always centered when zooming
Edit windows. Selected text will now remain centered when zooming in either
direction.

11. Fixed a bug in Standard Save (Save As... item) which misaligned all tabs in the
first line of a document by one character.

12. Fixed a bug in the Strip Returns Save (Save As... item) which ran together the
word at the end of one line with the first word at the beginning of the following line as it
stripped the return.

13. Added Apple Extended Keyboard support. The Apple Extended Keyboard
contains several additional keys that are now recognized by UtilityWorks when using
Text Edit windows. F2 will cut the selected text in the same manner as the Edit menu’s
Cut item. F3 will copy the selected text in the same manner as the Edit menu’s Copy
item. F4 will paste the selected text in the same manner as the Edit menu’s Paste item.
The del key will remove the character to the right of the insertion point if there is no
current selection, and will remove the selected text if there is a current selection. The
home key moves the insertion point before the first character of the document. the end
key moves the insertion point after the last character of the document. The page up key
moves the insertion point to the top of the current page, then scrolls up a page at a
time for every key press. The page down key moves the insertion point to the bottom of
the current page, then scrolls down a page at a time for every key press.

14. Added a Tree Search item to the Search menu. This routine will search all
selected text based files in a directory, tree branch, or entire disk for occurrences of
any user specified string. The user is first presented with a File Selection Dialog to
choose the files or directories he desires to search. The user then enters the search
string in the same manner as the Find String item. All selected files are then searched
in sequence. If the specified search string is not found in any of the selected files, an
advisory message will appear. If the string is found in any file, that file will be displayed
in a Text Edit window, with the first occurrence of the text string selected. All files
containing matches will be opened as Text Edit windows. Following completion of the
tree search, the user can find additional occurrences of the specified search string in
any file by using the Find Again item.

15. Corrected a tab misalignment when displaying AppleWorks files.
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The following features have been added to UtilityWorks version 1.0:

1. Now reset the output device to slot 3 prior to any text screen display (e.g.;
Launching... message) to avoid conflicts with NDAs that change the output device but
don’t restore it.

2. Corrected an error that only occurred when printer error messages were
displayed.

3. Added new Apple file type/auxiliary type assignments for UtilityLaunch menus
and UtilityWorks Backup files to the Set File Type routine.

4. Added Tool 53 (Speech Interface to GS/OS (from Byte Works)) to the Computer
Information routine.

5. Made minor changes in positioning of the Status Window in several routines.

6. Fixed a couple of bugs in the Install Fonts routine that prevented proper action
from  being taken when attempting to install fonts identical to already existing fonts.

7. Fixed a bug in the Install Fonts routine that resulted in font files not always being
properly closed.

8. Fixed a bug in the String Search routine that occasionally resulted in erroneous
matches when multiple file searches were made.

9. Added a capability to display 3201 files (in addition to 3200 files) and a
capability to display GIF files. Many thanks to Steven A. Bennett for the GIF LZW
decoder and to Dave Leffler for many other portions of the GIF routine. GIF and 3201
windows can be printed just like any other UtilityWorks windows.

10. Added a capability to print samples of all fonts contained in a directory in
addition to the already existing capability of printing  all currently installed fonts. This
gives the user the capability of printing samples of just those fonts contained on font
disks.

11. Added Apple’s new file type and auxiliary type assignment for UtilityWorks
Backup files to the Backup and Restore routine, as well as version 1.3 of the separate
UWGS.Restore program. The new file type is $E0 (LBR) and the new auxiliary type is
$8009 (known as UtilityWorks document). The UtilityWorks restore routine and
UWGS.Restore still recognize the old backup file designations. Also added a new
backup file to accommodate use of the new Apple assignments.

12. Added a new menu item, Grab Picture, to the edit menu. When Grab Picture is
selected a cross cursor appears. Align this cursor at the corner of a rectangular screen
area that you desire to grab. Press the mouse button and drag the mouse to the
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opposite corner of the rectangular area. You will see a “rubber band” outline of this
area. Release the mouse button when you are satisfied with the selected area.  The
standard arrow cursor reappears, but the indicated area has been copied to the
Clipboard as well as to an internal handle that is used for creation of new icons. You
can see the picture that was grabbed by selecting the Show Clipboard item.

13. A new Icon Editor was added. This routine is described in the UtilityWorks
documentation files.

14. A new Compare routine was added. This routine is described in the UtilityWorks
documentation files.

15. The previous Block Editor menu item has been changed to two separate items,
a File Editor item and a Block Editor item. Both items are described in the UtilityWorks
documentation files.

16. Corrected a bug in the Save As... routine that generated an extra space when
stripping returns from a text file.

17. Changed the Backup and Restore routines, as well as UWGS.Restore, to allow
the use of a 3.5 inch boot drive for backup and restore.

18. Added the capability to deactivate (using the Deactivate... menu item) any 3.5
inch drive so that it will not be used for backup, restore, bulk format, or bulk verify. This
gives the user the capability of choosing which disk drives will be used for these
routines. For instance if you have a second 3.5 inch drive that is a UniDisk, you may
not want to alternate between this drive and other drives because of its slow speed.
Likewise if you are booting from a 3.5 inch drive, you may not want to use it so you can
always have your boot disk on line. Devices deactivated with the Deactivate menu
item will be automatically reactivated the next time you select the Show Devices menu
item.

The following features have been added to UtilityWorks version 1.0.1:

1. Fixed a bug whereby a Compare File Buffer was improperly established.
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The following features have been added to UtilityWorks version 1.1.0:

1. Updated the About UtilityWorks, Help,  Edit Icons, Set  Colors, and Compare
and Block/File Editor display dialogs, as well as the Status Window used in several
routines, to work properly with the video keyboard or any other windows or dialogs that
may appear in front of these windows and dialogs. Added a Copyright dialog
selectable from the About UtilityWorks dialog.

2. Changed wording on Speed Up menu item and dialog. Also changed wording
on Catalog Data Base and Clear Backup Bits, and eliminated the separator line
between the New and Open menu items to more clearly indicate the functions of each
menu item.

3. Changed calls to ReadMouse to calls to GetMouse to work properly with Easy
Access NDAs.

4. Added an assembly language routine to speed up memory dereferencing in
situations when banks boundaries may be crossed.

5. Changed the password. Registered users can obtain the new password from
the author, George Wilde. A Shareware Alert message is now displayed when Quitting
UtilityWorks in addition to the Shareware Alert message  displayed  whenever
UtilityWorks is launched.

6. Added additional dynamic load segments and repartitioned UtilityWorks to
provide better performance in minimal memory configurations.

7. Added a wait cursor in several places to indicate processing is in progress. In
particular, a wait cursor is used whenever entering the file/directory selection dialog,
the selective restore dialog, and the filetype dialog. The wait cursor is also used
whenever the lists within any of these dialogs are being updated. Also changed the
alignment of the Unsort/Alphabetize button to improve the appearance of the
file/directory selection dialog. Changed the OK button in the file/directory selection
dialog, as well as the selective restore dialog and file type selection dialog, to read
Accept to be more consistent with the Standard File dialog terminology.

8. Now test version of operating system to see if System 6 is present. The fast port
QuickDraw routines are used if System 6 is present.

9. Now provide a warning message if large fonts can not be installed because of a
low memory situation.

10. Added Tool 38 (Media Control) to Computer Info.
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11. Now use the symbols > and >> in the Device Dialog to indicate respectively the
first and second device. If a single >> appears, the first and second devices are the
same.

12. Now remove and delete the internal icon handle whenever memory is purged
and the desktop is cleared.

13. The Out of Memory Queue buffer is now set at 64K and cannot cross a bank
boundary.

14. Now do not always switch to the Text Screen when changing modes or when
using the Speed Up routine. When do switch to the Text Screen, the background color
is changed to black and the text color is changed to white.

15. The file and block editor memory displays, as well as the compare memory
display, now use fewer controls for significantly improved performance. The
arrangement of the controls has been changed to allow mono-spacing (character 0
spacing) for better alignment of all characters, especially the ASCII characters. ASCII
control characters are now displayed as a period instead of the previous space. You
can now select the byte to edit with the file and block editor by clicking the mouse on
the ASCII character in addition to the Hex character.

16. Added an Install Driver menu item in the Utilities menu. This routine permits you
to install a device driver at any time. Drivers for such devices as Apple 5.25” disk
drives can be inhibited from loading using the Loader Actions menu item. With slot 6
set to Disk Port and the Apple 5.25” device driver inhibited, you can avoid the lengthy
slot 6 polling that occurs with many S16 programs. The 5.25” drive is still available for
P8 programs because they don’t use the GS/OS device drivers. If you have a program
that requires this 5.25” device driver, you can easily install the driver using this menu
item. To use this item simply select the desired driver to install from the Standard File
Selection dialog. UtilityWorks can install most non-supervisory GS/OS drivers except
for SCSI drivers that for the most part must be installed during the boot process.

17. Added an Install Init menu item in the Utilities menu. This routine permits you to
install a Temporary or Permanent Init at any time. For instance you can run the ZIP GS
Temporary Init at any time you want to restore your default ZIP GS settings. Not all Inits
can be installed while a Desktop application like UtilityWorks is being executed. For
instance the CloseView DA (really a Permanent Init) patches QuickDraw II and other
tools, and hence probably cannot be installed successfully by UtilityWorks. To use this
item simply select the desired Init to install from the Standard File Selection dialog.

18. Changed the name CDev to Control Panel to be consistent with System Disk
6.0 terminology.
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19. Fixed a bug in the line wrap routine for Graphics printing which did not properly
wrap text strings having no embedded space characters.

20. Improved the buffer allocation routine to better size the buffer used in most disk
and file operations to better use available memory while still reserving enough
memory for most tool calls and loading of dynamic segments.

21. Added several additional string types to the file/block editor update routine
including IEEE Single, IEEE Double, SANE Comp, IEEE Extended, Fixed, Frac, and
Binary. Also added a capability to sequence through the string types either forward or
backward (using the Open-Apple key in conjunction with the mouse button to
sequence backward).
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The following features have been added to UtilityWorks version 1.2:

1. Changed the 320 mode menu bar Scanline Control Bytes when displaying GIF
files to always display the menu bar using standard colors. This avoids the problem
that previously existed whereby the menu bar was often totally black when displaying
GIF files. Note that the pull down menus may still be illegible requiring you to use the
keyboard equivalents to make menu selections.

2. Added leading spaces to the “Changing modes” display.

3. Added an Undelete routine (previously named Exhume). This routine will
undelete user selected files or subdirectories previously deleted in any selected
ProDOS directory, provided that none of the previously deleted files’ blocks have
subsequently been reused by other files. . The user is first requested to select the
desired volume and directory using the directory selection dialog. The Undelete
routine, unlike other routines, will only work with ProDOS volumes. The user is next
presented with a list of all deleted files and subdirectories still present in the selected
directory (up to a maximum of 256 previously deleted files and subdirectories). Select
all files and subdirectories you desire to undelete and press OK. A file or subdirectory
may not be capable of being exhumed even though it appears in the list of deleted
files because some of its blocks may have been reused by other files. Undeleting is
most successful if it is performed immediately after deleting the file, with no intervening
disk writes that may use some of the blocks freed up by the deletion of a file or
subdirectory. You will be notified if the file cannot be exhumed because some of its
blocks are currently being used by other files. The file still may not be restored
correctly if several intervening file writes and deletes have taken place, even though
you receive no error message. This is because blocks previously used by the file you
are attempting to undelete may have been used by a new file and subsequently
released when that new file was deleted. Check any undeleted file carefully to make
sure it has been restored correctly. Undeleting a subdirectory will only exhume the
subdirectory itself, and no files within the subdirectory. To restore the files within the
subdirectory you must select the exhumed subdirectory and then select the files within
the subdirectory you wish to undelete. The undelete routine works with all ProDOS
files recognized by GS/OS, including subdirectory files, standard seedling, sapling,
and tree files, and extended files with seedling, sapling, or tree file structures in either
fork. The Undelete routine also works with sapling or tree file structure index blocks
with interspersed null entries. You cannot undelete files on your boot disk - you must
temporarily boot from another disk to undelete these files .

4. Now do not switch to the Text screen when launching P16 applications using
the Desktop (i.e.; those applications with an Auxiliary Type of $DB02, $DB03,or
$DB07).  When launching with the Desktop still visible on the SHR screen, the name of
the program being launched replaces the menu bar entries. Also now keep the SHR
Desktop screen up when Quitting.
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5 Fixed a bug in the display of the Tool 38 version number. Tool 38 should be
released with System Disk 6.

6. Widened the File/Directory Selection Dialog list boxes slightly to better display
file names for HFS (Macintosh) files, which are often somewhat longer than the 15
character maximum of ProDOS file names.

7. Installed a heartbeat interrupt into the File/Directory Selection dialog and the
Device Selection dialog to ensure that all disk changes will be detected.

8. Now permit double clicking to open single files in both the File Selection dialog
used for file copy, move, verify, and most other file operations, and the Restore dialog .
Multiple files should still be opened in the same manner as previously, by selecting the
files and clicking Accept, Data Fork, or Res. Fork. Single files can also still be opened
in this same manner. This change was made to be more consistent with the way the
Apple Standard File Operations tools work.

9. Fixed a bug that prevented proper list centering to previous selections in the
File/Directory Selection dialog.

10. Fixed a bug whereby the Wait Cursor was not reset in the File/Directory
Selection dialog when the “This disk is write protected” error message is displayed.

11. Added a Wait Cursor to both the File Editor and the Block Editor whenever a
disk read operation occurs. This is most noticeable with the File Editor when reading
very large files into a large extended memory. Also shortened the upper right hand
headers in both the File Editor and the Block Editor dialogs to allow display of the byte
and block values for very large files and volumes.

12. Fixed the Print Rectangle used in the File Editor, Block Editor, and Compare
routine print function to print the entire contents of the window.

13. Immediate return to File Copy, Move, Delete, Rename, and Verify operations
will now only occur if you hold down the Open-Apple key as the current operation
completes or when exiting from the successful completion dialog (if the “Show all Info.
Messages” default is selected).

14. Now delete the incomplete Icon file whenever a disk full error occurs when
saving Icon files.
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15. Icon file displays were previously created in a window which appeared on the
visible screen. Normally hardware shadowing was temporarily turned off so the build
up of the icon file display was not visible. However, if hardware shadowing was
already turned off, the buildup of the display was very visible. Icon file displays are
now totally created in an off-screen GrafPort; therefore the buildup of the display will
never be visible. Individual icons within the Icon File display are now enclosed in a
rectangle to more clearly identify the data associated with the icon.

The following features have been added to UtilityWorks version 1.2.1:

1. The AppleWorks display routine now recognizes the character 23 space
present in AppleWorks 3.0 Word Processor files.

2. A bug that occasionally resulted in clobbering the Blocks Remaining text after
creating a new folder has been fixed.

3. The total number of blocks contained on a volume that appears in the Catalog
display has been corrected. It previously was one block off in certain instances.

The following features have been added to UtilityWorks version 1.2.2:

1. A wait cursor is now used in the File and Block Editor function while the search
for the designated string is taking place.

2. A bug that prevented the Catalog Data Base from being saved whenever the
Desktop was cleared has been fixed.
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The following features have been added to UtilityWorks version 2.0:

1. Added a startup flag to prevent a momentary flash to black when launching a
program under System 6.

2. Revised the dialog update routines slightly.

3. Changed my area code in the Copyright dialog from Area Code 213 to Area
Code 310.

4. Added AppleShare to the list of File System IDs.

5. Added and corrected Device ID names.

6. Added a new routine to better select available Edit menu Cut, Copy, Paste, and
Clear menu items based on the status of Text Edit window selections and the contents
of the Clipboard.

7. Added a new Save menu item to the File menu. This item is activated if a Text
Edit window is the Front Window. Selecting Save will save the Text Edit window as a
Teach file to its original pathname. The user is prompted to select a pathname if the
window is a New window and therefore does not have an original pathname.

8. Whenever a Text Edit window that has been changed is closed (either by
clicking the Close box, selecting the Close menu item, or quitting UtilityWorks) a dialog
will appear asking the user if he wants to save the window. Selecting Save will save
the Text Edit window as a Teach file to its original pathname. The user is prompted to
select a pathname if the window is a New window and therefore does not have an
original pathname.

9. Added a new System 6 call to automatically poll most devices once a second. If
an unformatted disk is inserted, a dialog will appear asking to either initialize (format)
the disk or eject it. This call will detect disk changes even when dialogs appear on the
screen.

10. Changed the appearance of all dialogs to conform with Apple’s latest Human
Interface Guidelines. When System 6 is present the AlertWindows will also conform
with these guidelines.  The buttons at the bottom of the dialog will generally have the
action button on the right and the Cancel button (if any) immediately to the left.
Pressing enter or return will select the default (bold-outlined) button (usually, but not
always, the action button). Pressing esc or Command-period will select the Cancel
button if one exists. I Beam cursors will appear if the cursor is positioned over an Edit
Line item. With AlertWindow dialogs you can type the first letter of a button name
instead of clicking on it (unless some other button’s name has the same first letter).
This works with or without the Command key.
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The Standard File dialog also supports keyboard equivalents with System 6. You can
use the up and down arrow keys to select various items in the list. You can also type
one or more characters (including the beginning character of an item) to jump the
selection down to that item. (To use the first several characters of an item name, you
have to type one letter every two-thirds of a second or faster). Command-Tab moves to
the next volume. Command-period is the Cancel button, but esc isn’t in the Standard
File dialogs. Esc and Command-up-arrow are equivalent to the Close button (moving
the directory one level closer to the root directory). Command-esc or Command-D
jumps to the Volumes list. Clicking on the path item at the top of the list displays a pop-
up menu with one item for every level in the current path, all the way to the Volumes
list. Selecting any of these items takes you to the corresponding directory. Command-
O and Command-down-arrow are the Open button. In Save dialogs where you enter a
file name, Tab chooses between the edit line and the file list. Keystrokes go to
whichever one is active.

11. The menu bar clock is now active in almost all windows and dialogs.

12. Added several resources to UtilityWorks to facilitate better use in conjunction
with the new System 6 Finder. rIcons have been prepared for the UtilityWorks
program, the UWGS.Backup files, and all files that UtilityWorks can open. rVersion,
rComment, and rBundle resources have also been prepared for use with the System 6
Finder. Launching UtilityWorks the first time from the new Finder will install the
UtilityWorks rBundle. After the rBundle is installed, double clicking on any file icon
produced by UtilityWorks (all UtilityWorks file icons have a hammer at the right-hand
side of the icon) from the Finder will launch UtilityWorks and open or print the selected
files.

13. A reduced size version of UtilityWorks containing the UtilityWorks Restore
program (called UWGS.Restore) has been created and included on the UtilityWorks
distribution disk.  UWGS.Restore will easily fit on a single 800K System 6 Boot Disk,
and includes all of the UtilityWorks Restore capabilities, but none of the other powerful
UtilityWorks capabilities. It is designed to restore you hard disk boot partition from an
800K drive using previously generated UtilityWorks Backup disks. An installation script
has been included to create the UWGS.Restore boot disk using the System 6 Installer
and System Disk 6.0 disk set.

14. All Stop, Caution, and Note Alerts have been converted to AlertWindows.

15. The previous Status Window comment “Press Apple-period to Cancel” has
been changed to “Press Command-period to Cancel” to be consistent with Apple’s
desire to refer to the Open-Apple key as the Command key.

16. The key sequence to Save the SHR Screen Image to disk has been changed in
UtilityLaunch 2.3 and later from the previous OA-D to OA-J. This was done to avoid
confusion with the use of OA-D in Standard File dialogs to select the Volumes button.

17. A new file/directory selection dialog will appear when running under System 6.
Instead of being a dialog, it is really a Modal Window. Icons are used in the lists of files
and directories to indicate folders, documents, programs, etc. A pull-down menu is
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used to select any directory in the current path or the Volumes (Desktop icon)
selection. The sort is now non-case sensitive. Key presses can be used to select
individual items in the list or sequence through the list if the list is sorted. First
character search is used  for all searches except when Volumes are displayed, in
which case second character search is used. The Tab key can be used to alternate
between the two lists (if both lists are present) to select the active (target) list to receive
keypresses. This dialog functions almost identically to the Standard File Selection
dialog in System 6. Be sure to read the documentation file to fully understand how to
use of this new dialog.

18. Replaced the existing Device Selection Dialog used with Device (Volume)
routines (such as volume Copy, volume Verify, etc.) with a new dialog that contains a
list of all on-line devices and their volume names. Simply select the desired volume for
the operation. For volume Copy a single dialog with two lists (one for Source volume
and one for Destination volume) is now used in place of the previous two separate
dialogs. The new dialog should simplify volume selections, especially if you have
many on line devices. The same new dialog is also used for selection of the printer
device.

19. The Selective Restore, Change File Type, and Undelete dialogs that contain
lists of files have been changed to appear similar to the Standard File Selection
dialog. The lists in either dialog will appear sorted or unsorted depending on the last
setting of the Sort/Unsort button. If the lists are sorted, either first or second character
search is available for keyboard entries depending on the specific list. Lists that
contain a first character of “:”, “.”, or “$” use second character search.

20. Previous Fake Modal dialog calls have been changed to Modal Window calls
when System 6 is present.

21. Rename, Volume Name, File Search, and New Folder routines now use the
System 6 JudgeName call (if System 6 is present) to ensure that the entered name is
consistent in syntax with the selected file system. If there are syntax errors, a
suggested alternative name is presented. A brief statement of the syntax rules for the
designated file system will also appear in the dialog. The Format and Erase menu
items also utilize the JudgeName call to check the entered volume name.

22. The Volume Rename routine will now function correctly when renaming a
volume with duplicate volumes online.

23. Fixed a bug in the Undelete routine that caused UtilityWorks to crash when
undeleting from a different directory after an unsuccessful Undelete.

24. Added a $8000 AuxType to Icon files and Type $BC Load files in the Set File
Type routine to allow activation/deactivation of these two file types. Whenever either of
these file types have a $8000 AuxType the files will be inactive under System 6. This is
very handy for selecting, for instance, what icon files the System 6 Finder should use.
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25. Several UtilityWorks AlertWindows ask the user to insert a specified disk. These
AlertWindows in general contain a disk swap icon. When such AlertWindows appear
and System 6 is present, inserting any disk will automatically close the AlertWindow.

26. Removed all automatic setting of prefixes below prefix 8, except when
launching P8 programs, where prefix 0 is set to the pathname of the directory
containing the program being launched to ensure maximum compatibility with many
current P8 programs.

27. Changed the default name for new volumes to Untitled rather than NewDisk.

28. Corrected the handling of option lists in the Backup/Restore routines and Copy
routine to be consistent with Apple’s new guidelines regarding option lists. Option lists
now contain the Macintosh Finder information when accessing HFS disks. This
information will be always saved in the Backup routine and restored in the Restore
routine when backing up HFS disks. This information will also be saved when copying
files, except when copying a non-extended HFS file to a ProDOS disk. Option lists for
extended HFS files are saved in the corresponding extended file index block on
ProDOS disks.

29. Changed the file selection logic for the display routine to recognize only the
unpacked file types supported by UtilityWorks.

30. Added a wait cursor to the Save As routine.

31. When System 6 is present, UtilityWorks will now recognize additional volumes
that may suddenly come on-line. For instance, if a CD ROM is suddenly inserted that
has five partitions instead of the previous single partition on the original CD ROM,
UtilityWorks will recognize these extra partitions automatically. The scroll bar on the
Devices dialog will also be expanded to cover these additional entries.

32. A capability has been added to display Word Perfect files.

33.  Pressing the Option key while selecting Close from the Files menu closes all
windows. Pressing the Option key while selecting a window from the Windows menu
will close that specific window.

34. Added the additional $17 AuxType to the APW file type in the Set File Type
routine  for Installer Script Files.

35. Added a Get Info... menu item to the Files menu. The Get Info. routine displays
all relevant information about any specific file you select with a Standard File
Selection dialog. The information includes practically all of the information contained
in the Catalog. The “size” entry is the sum of the end-of-file positions for the data fork
and resource fork. The “on disk” entry is the sum of the number of blocks contained in
the data fork plus resource fork plus one converted to KBytes. If the file has an rVersion
resource, the version number and version data entries are displayed. If the file has an
rBundle resource and associated rIcon resources, the icon for this file is displayed. If
the file has an rComment resource, the Comment is displayed. The comment appears
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in a Text Edit window which can be modified and saved by the user. You can enter any
comment information you desire, even if no rComment exists in the selected file. If no
rComment exists and you desire to add an rComment to a file, UtilityWorks will add a
resource fork to the selected file (if one does not already exist) and add your
rComment. You will be warned when adding an rComment to a file that does not have
a resource fork makes the file unreadable by any ProDOS 8 application. ( A Remove
Resource routine has been added to UtilityWorks to remove resource forks from files to
make them once again readable by ProDOS 8 programs).  Please note that
rComments cannot be attached to $F9 and $FF files, and UtilityWorks will not let you
add rComments to these file types. rComments are a very handy means of adding
short notes to your files to keep track of what is in them.

36. A Remove Resource menu item has been added to the Path menu. The
Remove Resource routine allows you to completely remove a resource fork from a file
to make it recognizable by ProDOS 8 programs. The Delete routine will delete a
resource fork. That removes all resources in the resource fork and sets the resource
fork file length to zero. But the file still contains an empty resource fork, which makes it
unrecognizable to ProDOS 8 programs. Use Remove Resource to completely remove
the resource fork. Remove Resource will only work with ProDOS files.

37. Added a capability to read rIcon resources with the Icon Editor. You can now
either select Finder Icon Files or any extended file for use with the Icon Editor.
Whereas multiple Finder Icon files can be selected and combined, only a single
extended file can be selected.  You will be notified if the selected extended file
contains no icons. rIcons contain no pathname, filename, or file type/auxiliary type
information. Therefore this information will be blank when reading in extended file icon
resources. You should enter the appropriate information before saving the selected
icons as a Finder Icon file. The Icon Editor automatically determines whether a given
icon is a large icon or small icon, and displays it accordingly. To sequence through just
large icons (skipping all small icons) hold down the Option key while clicking on the <<
or >> buttons. To sequence through just small icons (skipping all large icons) hold
down the Command (Open-Apple) key while clicking on the << or >> buttons. You can
click on the Set Small button to choose a default small icon. Please note that you must
choose both a large icon and small icon to save resource icons as a Finder Icon file.

38. A new menu item has been added to the Edit menu to create an rBundle for any
selected S16 application. rBundles are new to System 6. The Finder uses rBundles to
determine which icon to display for any given file, and which program (if any) to launch
when an icon is selected. The new System 6 Finder will automatically generate
rBundles from the Finder Icon files in the Icons folder unless the Finder Icon Files have
been deactivated. These rBundles are stored in the new Desktop file that is created in
each volume’s Icons folder. Many new applications designed for use with System 6
will contain their own rBundles that specify the icons to use for the application itself
plus any documents it claims. UtilityWorks and UtilityLaunch now both contain
rBundles that identify the icons to use for both UtilityWorks or UtilityLaunch, as well as
the files they own such as UL.Menus. UL.BOOT, and UWGS.Backup files. The first time
you execute these programs with the new System 6 Finder, the Desktop file will be
updated with this new rBundle information. The rBundles allow applications to vote on
who should handle specific documents. For instance UtilityWorks can open many
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different types of Graphics and Text documents and can save these documents in one
of several formats. As an example, UtilityWorks can open and display WordPerfect
files. If UtilityWorks is present,  selecting a WordPerfect document with the Finder
should result in UtilityWorks being launched to display that file - that is unless
WordPerfect itself is present, in which case the user would probably prefer
WordPerfect be launched to display the file. The Finder resolves these apparent
conflicts by allowing each application to vote on specific files. If an application can only
open a file (for instance UtilityWorks can only open WordPerfect files) it is given the
lowest priority for that file type. If an application can write to the file it is given a higher
priority.  If an application can write to the file in the original file format it is given an
even higher priority. If an application owns a file (for instance WordPerfect owns
WordPerfect document files) it is given highest priority. Therefore, in the above
example, if both UtilityWorks and WordPerfect were present and had appropriate
rBundles, selecting a WordPerfect document would result in WordPerfect being
launched because it has a higher priority.

Unfortunately, most applications do not currently have rBundles. Therefore, if
UtilityWorks were to claim a number of the documents it can open at the lower priority,
it would still be the highest priority for these documents because the true owner
applications do not have a rBundles to claim the documents. To get around this
problem, UtilityWorks provides a capability to create a voting rBundle for any S16
application you desire. UtilityWorks has a default rBundle that claims only the
documents it owns (namely its UWGS.Backup files). A separate Finder Preferences
menu item has been added to allow UtilityWorks to expand its own rBundle to add any
or all of the documents it can open.

To use Create rBundle first select the S16 program you want to add the rBundle to.
Create rBundle works with existing Finder Icon files. Now Select the Finder Icon file(s)
for the S16 program. Sequence through the icons until you arrive at the icon for the
S16 program itself. It is very important that the first icon you select is for the program.
Make sure that the filename and file type information is correct and make sure that the
radio button claiming ownership of the file is selected. Now press Add to rBundle.
Continuing sequencing through the Finder Icon file until you identify all documents you
want to claim. For each such document, verify the filename and file type information.
Choose the appropriate voting priority, then press Add to rBundle to add that
document to the program’s rBundle. When you have finished this process, click Save
to actually save the rBundle in the program’s resource fork, and press Cancel to exit
without saving. Executing the program will add the rBundle to the Finder’s Desktop file,
and activate all of your document selections.

39. Added a Finder Preferences menu item to the Utilities menu. The Finder
Preferences routine allows you to add to the UtilityWorks rBundle a claim for any of the
documents that UtilityWorks can open. Simply select (check) those file types that you
want UtilityWorks to open when that particular file type is selected from the Finder.
When you have completed your selections, click OK to modify the UtilityWorks rBundle
and click Cancel to exit without change. Now launch UtilityWorks from the Finder and
the new rBundle information will be added to the Desktop file. Since the Finder will
only add information to the Desktop file if the program’s rVersion number has
increased, if you desire to subsequently change the files you want UtilityWorks to
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handle from the Finder you will need to delete the Finder’s Desktop file from the
volume that contains UtilityWorks to allow the Finder to regenerate the rBundle
information. (UtilityWorks modifies the rVersion number the first time that the rBundle is
modified - therefore only subsequent modifications will be ignored). Make sure you
select only those files you want UtilityWorks to handle. I do not recommend that you
select Applesoft BASIC files. Doing so will prevent Applesoft programs from being
executed from the Finder (instead they will be opened and displayed in a UtilityWorks
window).

40. Corrected a bug in the Print Fonts routine that resulted in Font Family Numbers
greater than 32,767 being incorrectly printed in the title line of the sample printout.

41. Added an extra line of information in the Memory Window. This line shows the
breakdown of how the currently used memory is divided between UWGS
(UtilityWorks), System (GS/OS Operating System, Loader, Tools, Drivers, etc.), Setup
Files, and Desk Accessories. This gives the user a better idea of how much of his
memory is being consumed by Setup files and Desk Accessories. If you are in a low
memory situation, disable unneeded Setup files and Desk Accessories using the
Loader Actions menu item in the Utilities menu.

42. Changed the terminology used in the File Selection/Directory Selection dialog.
Res. Fork has been changed to Resource and Alphabetize has been changed to Sort.

43. Fixed a bug that prevented proper string search of Text Edit files having a size
greater than 65,535 characters.

44. Added a WaitCursor to the String Search routine.

45. Added a capability to Launch Applesoft BASIC files from the Launch menu item.

46. Added two keyboard equivalents to the File Editor and Block Editor HEX/ASCII
File or Block contents display. Command-F is equivalent to the Read button and will
display the dialog to enter a String or HEX word to search for. Command-G will
continue the search for the next occurrence of the String or HEX word. Command-G
will only continue the search if a previous String or HEX word was entered. These
keyboard equivalents are the same as the ones used in the menu bar to search Text
Edit files.

47. Added a Resource Editor routine. The Resource Editor routine provides a
capability to edit resources in any extended file (i.e.; file containing a resource fork).
The user is first requested to select a file using the Standard File Selection dialog. If
the file contains any resources a dual list appears in a dialog which contains the
resource types contained in the file in the left-hand list and the resource IDs contained
in the file for the selected (highlighted) resource type. First select the desired resource
type then select the specific resource ID you desire to edit. Next choose the desired
operation to perform. Delete deletes the resource from the file. Edit presents a
HEX/ASCII display essentially identical to that used in the File Editor. Make any
desired changes in this display. Press Write to change the resource and press OK to
return to the Resource List. Copy copies the selected resource to another file. After
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pressing the Copy button, a Standard File Selection dialog will appear. Select the
destination file from this dialog. New Type changes the resource  type and New ID
changes the resource ID. With either New Type or New ID, enter the desired new
resource type or new resource ID in the dialog that appears. Press OK to make the
change or Cancel to return without making any changes.

48. Corrected a bug that resulted in incorrect setting of string changes in the File
Editor when editing files containing fewer than 256 characters.

49. Now exit the Copy routine when a volume becomes full. UtilityWorks no longer
attempts to copy additional files to the disk even though some files may fit in the
remaining space on the disk.

50. Added an additional warning message when copying a file to a directory
already containing the same file. If the existing file in the directory has an earlier
modification date (i.e.; the new file is a more recent version), the warning message
asks you whether you want to replace an earlier dated file, with a Yes default. If the
existing file in the directory has the same or a later modification date, the warning
message asks you whether you want to replace an existing file, with a No default. This
feature is very handy when updating a series of files in a directory in which only a few
files have changed. Pressing the return key as each warning message appears will
result in only the newer versions of the files being copied to the directory.

51. Fixed a bug that resulted in erroneous display of file date information when the
year is calendar year 2000.
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The following features have been added to UtilityWorks version 2.0.1:

1. Improved the performance of the Hex Conversion routine used to compute Hex
file types.

2. Changed the Print Screen and Save Screen routines to use the current screen
display buffers wherever they are located.

3. Changed the Finder Preferences routine to increment the rVersion number so
that each change will be recognized by the Finder. Also changed the Create rBundle
routine to do the same provided the rVersion was created by UtilityWorks.

4. Added a short catalog routine that displays a single line of information for each
file regardless of its type. File names longer than 15 characters are truncated to 15
characters with an added trailing “>“ character to indicate that characters have been
omitted. Extended files are indicated by a “*” character appearing after the number of
blocks. With extended files, blocks represent the sum of data fork blocks and resource
fork blocks and EOF represents the sum of the data fork EOF and the resource fork
EOF. The short catalog is now the default catalog, including the default startup catalog.
The previous long catalog will appear if you press the Command (Open-Apple) key as
you select the Catalog menu item from the Path Menu.

5. UtilityWorks cannot directly install TrueType fonts. It requires Pointless to install
any TrueType font. Therefore TrueType fonts are no longer selectable in the Open,
Load Fonts, or Print Fonts menu items. If a given TrueType font has already been
loaded by Pointless, or if a TrueType font has a corresponding bit-mapped font from
the same family currently in the *:System:Fonts directory, the Print Fonts routine will
print the TrueType version of this font if a size 14 version of this font does not already
exist. As the font is generated, the Pointless wait circle is filled in. TrueType fonts will
only be used if you choose to print a sample of all font families contained in the Font
Manager’s list of fonts. Print Fonts will not recognize TrueType fonts contained in any
directory. The UtilityWorks text editor can use TrueType fonts at any time. Just choose
the Select Fonts menu item to select any desired font, including TrueType fonts.
Likewise the View Fonts menu item can be used to display any standard or TrueType
font. The resulting windows can obviously be printed using the TrueType fonts.

6. Corrected a bug that could result in the program crashing when editing
resources whose size was less than 256 bytes.
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The following features have been added to UtilityWorks version 2.0.2:

1.      Added an “Icon file too large” error dialog to the Icon Editor which appears when
attempting to create an icon file that exceeds 64K in size. Previously this situation
would result in a memory error with an indication that 0K additional memory was
required.

2.      Several changes were made in the driver installation routine to more reliably
install drivers.

3.      No attempt is now made to install Desk Accessories, Permanent Inits, or Drivers if
they have already been installed. This avoids the duplication of CDAs and NDAs in the
corresponding Desk Accessory list. A warning message now appears if the selected
Desk Accessory, Init, or Driver has already been installed.

4.      The Computer Info. window now shows the Total Blocks of FSTs like Macintosh
(HFS) and Apple II Pascal as $FFFFFFFF instead of the previous -1.

5.      The Save menu item is now only selectable when a Text Edit window that
contains an original Teach file or a new file appears as the front window. Save will
only save a file in Teach format. Since Text Edit windows can also be generated from
other types of files, this avoids overwriting a previous file in some other format with a
Teach format file.  Use the Save As menu item to save in other formats. Please note
that a Text Edit window that has been altered but not saved, will still be saved in Teach
format if the user elects to save the file when the Text Edit window is closed.

6.      Two new keyboard equivalents can now be used to perform either Graphics
printing or Text printing without using the Graphics/Text print dialog that appears for
certain text based files when the Print menu item or Command-P keyboard equivalent
is selected. Use Command-R to directly perform Graphics printing and use Command-
T to directly perform Text printing. Command-T will only be functional for those files
that can be printed in Text mode.

7.      The Save As menu item now utilizes a custom Standard File Selection dialog
when saving Text based windows. If the front window is a standard window that
contains text, three radio buttons will appear in the dialog. These buttons allow choice
of the text save mode (Quick Save, Standard Save, or Strip Returns), and avoid the
need for the previous separate dialog to make these choices. If the front window is a
Text Edit window, two radio buttons will appear in the dialog. These buttons allow
saving the file as either a Teach file (the default) or as a Text file. If Text file is selected,
the additional three text save mode radio buttons will appear to allow choice of the text
save mode. Using this custom dialog avoids the need for two separate dialogs to make
the Save As option choices.

8.      The Create rBundle routine previously added rBundles to only S16 program files.
Version 2.0.2 adds the capability of adding rBundles to any file type. Simply hold the
Command (Open-Apple) key down as the Create rBundle menu item is selected, and
any file can be selected for adding an rBundle. Please note that any file you add an
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rBundle to will be unusable by ProDOS 8, so choose your files wisely. Also note that if
the Finder already has an in-place rBundle that covers your selected file, the new
rBundle may not take effect.
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The following features have been added to UtilityWorks version 2.1:

1. A correction was made to the UtilityWorks rBundle. In accordance with Apple
guidelines no optional descriptor is used. Also changed the Finder Preferences
routine to account for this change.

2. Changed all references to "volume" to "disk" to be consistent with Apple's new
naming conventions in System 6.0.1. This change appears in many dialogs and Alert
messages, as well as in the documentation files.

3. Changed the name of a newly formatted disk from "Untitled" to "untitled", again
to be consistent with Apple's new naming conventions in System 6.0.1.

4. Corrected a problem in several UtilityWorks routines which could occur when
reading directories on servers. You should no longer get an Error 61 indicating the
end of the directory has been reached. Earlier versions of UtilityWorks could crash if
the server had folders that were not accessable to the Apple IIGS.

5. Command F brings up the control panel's Find File NDA with System 6.0.1
unless a Text Edit window is the Front Window. In this latter case the Find String
Dialog appears to search for text strings in the Text Edit window.

6. Incorporated the latest published Apple File Types in the Set File Type routine.
Also improved the Set File Type dialog to provide more space for list entries.

7. Fixed the GIF Error Message so that it is no longer a blank error message with
no error codes. This error message can appear in such situations as when the GIF file
is to large to read.

8. Changed the Get Info, Create rBundle, Icon Editor, and Resource Editor
routines so that they no longer automatically load preload resources.

9. Added an error message to the Icon Editor to indicate the icon file can not be
created unless both a large icon and a small icon have been selected. Previously the
routine exited with no warning whenever this situation occurred, making it difficult to
tell why the icon file was not created.

10. In the Backup routine, if a read error occurs when verifying a backed up disk,
the error message now shows the device on which the error occurred.

11. In the Backup routine, added an error exit to the routine writing the reference file
at the conclusion of the backup. Previously, if this disk were write protected, or some
other error occurred, an undesirable set of error conditions appeared.

12. Changed the "DOS 3.3" FST name to "Apple II DOS 3.3" to be consistent with
Apple's latest naming conventions in System 6.0.1.
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13. The Select Ruler, Select Color, and Select Font routines used when editing
Text Edit windows now show the existing settings of the selected text in the Text Edit
window rather than standard default settings. This should make these menu items
much easier to use.


